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Get started

Copyright © 1995-2021 Esri. All rights reserved.



ArcGIS Data Appliance: OpenStreetMap Vector Basemaps

What is ArcGIS Data Appliance: OpenStreetMap Vector
Basemaps?

OSM Vector Basemaps provides detailed maps from contributors with local knowledge that you can use with your
ArcGIS and web applications. Vector tiles enable dynamic cartography and provide the flexibility to create your own

basemap style. The vector basemaps are available as tile layers that can be added to existing maps as either a
basemap or an overlay layer.

OSM Vector Basemaps provides a content solution that works with ArcGIS Enterprise. It is included (shipped
separately) with ArcGIS Data Appliance 2022 with World Standard, World Advanced, North America Standard, and
North America Advanced product options. It can also be licensed as a stand-alone option.

I Note:
This feature is not included with the World Basic product option.

The OSM Vector Basemaps help includes the following topics:
+ OSM Vector Basemaps content

« Directory of map styles

« System requirements

» Set up OSM Vector Basemaps

« Information on how to use OSM Vector Basemaps

» Methods to customize OSM Vector Basemaps styles

« Reference information including FAQs, Troubleshooting, and Support

Copyright © 1995-2021 Esri. All rights reserved. 4
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OSM Vector Basemaps content

OSM Vector Basemaps is delivered on a USB flash drive loaded with two vector tile packages, styles, and a style
publishing toolbox (.tbx file).

I Note:
OSM Vector Basemaps ships separately.

This version includes the following:

« Installation vector tile packages that you upload to your ArcGIS Enterprise portal using ArcGIS Pro and publish as
a hosted vector tile service on your hosting server:
= OSM_Vector_Basemap_DA2022_Install.vtpk—A vector tile package for customers who want to use Web

Mercator Auxiliary Sphere (WMA).

= OSM_Vector_Basemap_GCS_DA2022_Install.vtpk—A vector tile package for customers who want to use
OSM Vector Basemaps in WGS84 Geographic (GCS). This .vtpk file uses the WGS84 Geographic, version 2
tiling scheme.

« Map styles (for each projection) that you publish as vector tile layers to your Enterprise portal to use in your maps
and apps or customize. These styles require resources included in the VectorBasemapStyles folder for publishing.

« Vector Style publishing tools for managing your vector basemap tile layers (map styles) in your Enterprise portal:
* VectorStylePublisher.tbx—This toolbox is used to create vector basemap tile layers.

= VectorStyleUpdater.tbx—This toolbox is used to update existing vector basemap tile layers.

» Map style text files to help you with map style updates:
= DA2022_0SM_WMA_StyleUpdater_template.csv—This file manages WMA styles.

= DA2022_0SM_GCS_StyleUpdater_template.csv—This file manages GCS styles.

« Documentation file data_appliance_osm_vector_basemaps.pdf that includes instructions for getting started,
setup, using OSM Vector Basemaps, and more.

I Note:

Do not use the OSM_Vector_Basemap_DA2022_Install and OSM_Vector_Basemap_GCS_DA2022_Install vector tile
packages for anything other than publishing the tile layer (hosted). Once you publish the tile layer to your
Enterprise portal, do not share the .vtpk files publicly (Everyone), as distribution of these items outside of your

organization is not permitted.

Copyright © 1995-2021 Esri. All rights reserved. 5
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What's new

This update of ArcGIS Data Appliance: OpenStreetMap Vector Basemaps contains two updated vector tile packages
(. vtpk files) used to publish as hosted vector tile services in your ArcGIS Enterprise portal. One is in the Web
Mercator Auxiliary Sphere (WMA) projection and the other is in the WGS84/GCS (GCS) tiling scheme. Map styles can
be published as vector tile layers for each option.

These vector tile packages contain updated global data and local authoritative data from the OpenStreetMap
community through the inclusion of Daylight Map Distribution of OpenStreetMap data. This map distribution is
intended to leverage the work of the OSM community and enhance that with additional data validation to detect
and remove map vandalism and geometry errors. This dataset also includes an expansion of the coverage of
buildings in the map beyond those contributed by the OSM community.

All of the OSM Vector Basemaps vector tile layers (map styles) include cartographic styling refinements. Because of
the upgrade to Daylight data, users who customized OSM tile layers using ArcGIS Data Appliance 7.2 need to
update these tile layers and reapply the style refinements.

Existing users of the vector basemaps in ArcGIS Data Appliance can update the hosted tile layer as well as update
nine styles from version 7.2. The VectorStyleUpdater toolbox uses a template of existing item IDs and can be run in
ArcGIS Pro. A new style, OpenStreetMap (Blueprint), can be published with the VectorStylePublisher tool.

OSM Vector Basemaps now contains a total of 10 vector tile layers (map styles).

New users can publish any or all of the full set of 10 styles.

Copyright © 1995-2021 Esri. All rights reserved. 6
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Directory of map styles

OpenStreetMap (OSM) Vector Basemaps includes the following 10 vector tile layers. The styles can be published in
the Web Mercator Auxiliary Sphere (WMA) projection or the WGS84/GCS (GCS) tiling scheme.

Layer name and

thumbnail Style folder name

OpenStreetMap

[115 B
S

s d " openstreetmap
OpenStreetMap (with
Relief)

openstreetmaprelief

OpenStreetMap (Esri
Street style)

openstreetmapesristreetstyle

OpenStreetMap (Esri
Street with Relief style)

openstreetmapesristreetreliefstyle

OpenStreetMap (Esri
Hybrid Reference style)

e = 7 | openstreetmapesrihybridstyle
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Description

This tile layer provides a vector
basemap of OSM data created by
Esri. This vector tile basemap was
authored in ArcGlIS Pro from a live
replica of OSM data that was
rendered using OSM cartography.

This tile layer provides a vector
basemap of OSM data created by
Esri. This vector tile basemap was
authored in ArcGlIS Pro from a live
replica of OSM data that was
rendered using OSM cartography.
This layer is designed for use with the
World Hillshade layer.

This tile layer provides a vector
basemap of OSM data created by
Esri. This vector tile basemap was
authored in ArcGIS Pro from a live
replica of OSM data that was
rendered using a cartographic style
similar to the Esri Vector Basemap
World Street Map style.

This tile layer provides a vector
basemap of OSM data created by
Esri. This vector tile basemap was
authored in ArcGIS Pro from a live
replica of OSM data that was
rendered using a cartographic style
similar to the Esri Vector Basemap
World Street Map (with Relief) style.
It is designed to be used with the
World Hillshade layer.

This tile layer provides a vector
basemap of OSM data created by
Esri. This vector tile basemap was
authored in ArcGlIS Pro from a live
replica of OSM data that was
rendered using a cartographic style
similar to the Esri Vector Basemap
Hybrid Reference Layer style. This
layer is designed to be overlaid on
imagery.
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Layer name and
thumbnail

OpenStreetMap (Esri
Dark Gray Canvas Base)

OpenStreetMap (Esri
Dark Gray Canvas
Reference)

LY A\

o Vpem I
N/ -
\ m o

OpenStreetMap (Esri
Light Gray Canvas Base)

OpenStreetMap (Esri
Light Gray Canvas
Reference)

London

OpenStreetMap
(Blueprint)

Style folder name

openstreetmapesridarkgraycanvasbase

openstreetmapesridarkgraycanvasreference

openstreetmapesrilightgraycanvasbase

openstreetmapesrilightgraycanvasreference

openstreetmapblueprint
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Description

This tile layer provides a vector
basemap of OSM data created by
Esri. This vector tile basemap was
authored in ArcGlIS Pro from a live
replica of OSM data that was
rendered in dark neutral colors.

This tile layer provides a vector
basemap of OSM data created by
Esri. This vector tile basemap was
authored in ArcGlIS Pro from a live
replica of OSM data and features
map labels for use with the Dark Base
layer.

This tile layer provides a vector
basemap of OSM data created by
Esri. This vector tile basemap was
authored in ArcGIS Pro from a live
replica of OSM data that was
rendered in light neutral colors.

This tile layer provides a vector
basemap of OSM data created by
Esri. This vector tile basemap was
authored in ArcGlIS Pro from a live
replica of OSM data and features
map labels for use with the Light
Base layer.

This tile layer provides a vector
basemap of OSM data created by
Esri. This vector tile basemap
presents the map in a creative
cartographic style resembling a
blueprint technical drawing. This style
is not designed for use in ArcGIS
Enterprise 10.7.1.
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Frequently asked questions

Listed below are frequently asked questions and answers regarding ArcGIS Data Appliance: OpenStreetMap Vector
Basemaps.

« How does ArcGIS Data Appliance: OpenStreetMap Vector Basemaps work?

+ How do | set up OSM Vector Basemaps?

« Where does the data come from?

+ Does OSM Vector Basemaps include imagery?

» What services are available?

« Are there any use restrictions when using OSM Vector Basemaps?

« Where can | find more information about editing custom styles?

» Where can | find more information about using basemaps in my Portal for ArcGIS Map Viewer Classic?

* What if | need further assistance?

How does ArcGIS Data Appliance: OpenStreetMap Vector Basemaps work?

ArcGIS Data Appliance: OpenStreetMap Vector Basemaps (OSM Vector Basemaps) is published as a hosted vector
tile service from your ArcGIS Enterprise portal along with nine map styles that you can share, use, and customize
within your organization. For more information on vector basemaps and the differences between raster and vector
tile layers, see Tile layers in the Portal for ArcGIS help.

How do | set up OSM Vector Basemaps?

Refer to the instructional video and help documentation on the OSM Vector Basemaps Additional resources section
of the ArcGIS Data Appliance 2022 website to learn how to set up and use OSM Vector Basemaps.

Where does the data come from?

The data is provided exclusively by Esri (OSM) and its contributors through the use of the OSM Daylight Map
Distribution data. Esri uses this Daylight Map Distribution data in addition to an expanded building footprint
dataset that is a companion to Daylight. This data is used to author the map using OSM cartography and generate a
vector tile package.

Does OSM Vector Basemaps include imagery?

No. OSM Vector Basemaps does not include raster basemaps or imagery.

What services are available?

OSM Vector Basemaps only requires one service published as a hosted vector tile layer from your portal. Other
maps are included as map styles that you publish to your portal as tile layers. See Directory of map styles for the
vector tile layers included with OSM Vector Basemaps.

Copyright © 1995-2021 Esri. All rights reserved. 9


https://enterprise.arcgis.com/en/portal/latest/use/tile-layers.htm
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Are there any use restrictions when using OSM Vector Basemaps?

The OSM Vector Basemaps provided via ArcGIS Data Appliance are intended for use with Esri software.
Redistribution rights are granted by Esri and the data vendor for hard-copy renditions or static, electronic map
images (for example, .gif and . jpeg) that are plotted, printed, or publicly displayed with proper metadata and

source or copyright attribution to the respective data vendor or vendors. For copyright and attribution information,
see Credits for a specific map published to your portal.

Where can | find more information about editing custom styles?

View the Working with and Customizing Esri Vector Basemaps: The Basics post on the ArcGIS Blog website for more
information about editing custom styles.

Where can | find more information about using basemaps in my Portal for ArcGIS Map Viewer Classic?
See Customize basemaps and Choose basemap in the Portal for ArcGIS help for more information about using

basemaps in your Portal for ArcGIS Map Viewer Classic.

What if | need further assistance?

For all questions, feedback, and troubleshooting, and to report issues, contact Esri Technical Support.

Copyright © 1995-2021 Esri. All rights reserved. 10
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System requirements
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OSM Vector Basemaps system requirements

The following software components and prerequisites are required before you deploy OSM Vector Basemaps:
« ArcGIS Pro Basic, Standard, or Advanced 2.8 or later

« An ArcGIS Enterprise 10.7.1, 10.8, 10.8.1, or 10.9 deployment meeting the base ArcGIS Enterprise deployment
specifications

I Note:
Authentication exclusions—The Linux public-key infrastructure (PKI) configuration is not supported.

Before you start
Before you begin your deployment, do the following:

1. Check with your portal administrator to verify or request the following:
+ A Portal for ArcGIS account with the Publisher or Administrative role enabled.

« A named user license enabled for ArcGIS Pro Standard or Advanced.

« A minimum of 82 GB of available space per .vtpk file for your portal content directory, 41 GB of available
space for your hosting server’s jobs directory, and 41 GB of available space for your hosting server’s cache
directory.

2. Check with your ArcGIS Server administrator to verify or request the following:
« A minimum of 82 GB of available disk space per .vtpk file on your ArcGIS Server.

 Enough pooling time for your ArcGIS Server. Successfully publishing a large .vtpk file as a hosted vector tile

service requires more time for the web client to communicate with ArcGIS Server. Check with your ArcGIS
Server administrator to confirm that the The maximum time a client can use a service option is set to
21,600 seconds.

The following steps walk you through this process for ArcGIS Server 10.7.1, 10.8, 10.8.1, or 10.9:

+ Open a new browser and access ArcGIS Server Manager, for example, https://PORTALNAME/server/
manager, and sign in.

+ Click Site (root) > System > PublishingTools.

« Click Pooling, and under Specify Service Timeouts, change the value for The maximum time a client
can use a service from 3,600 seconds (1 hour) to 21600 seconds (6 hours).

@ S Server Manager T B
Manage Services 0GC Services KML Netwark Links Sharing
Editing: Site (root) > System > PublishingToals Help Save and Restar
C il
R umibe In
Tiber st I
Capabilities
- ” |

» Click Save and Restart.

Copyright © 1995-2021 Esri. All rights reserved.
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ArcGIS Data Appliance: OpenStreetMap Vector Basemaps

« Sign out of ArcGIS Server Manager.

3. ArcGlIS Data Appliance 2022: OSM Vector Basemaps is delivered on a USB flash drive loaded with vector tiles,
styles, and style publishing tools. Copy all contents of the USB flash drive to your local computer.

Copyright © 1995-2021 Esri. All rights reserved.
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Setup
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Set up ArcGlIS Data Appliance: OpenStreetMap Vector
Basemaps

Instructions for how to set up ArcGIS Data Appliance: OpenStreetMap Vector Basemaps depend on whether you are
a new or existing user, as follows:
* New user

« Existing user

When you've completed setting up ArcGIS Data Appliance: OpenStreetMap Vector Basemaps, your vector
basemaps will be ready to use.

Copyright © 1995-2021 Esri. All rights reserved. 15
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Set up OSM Vector Basemaps (new user)

For information about what's included with OSM Vector Basemaps, see OSM Vector Basemaps content.

I Note:
Before you proceed, review the system requirements to confirm that you can deploy OSM Vector Basemaps on your

system.

Once you confirm that the system requirements are met, the workflow to set up OSM Vector Basemaps is as
follows:

1. Upload the package to your ArcGIS Enterprise portal
2. Publish the hosted tile layer (service)

3. Publish tile layers (map styles)

4. Share tile layers (map styles)

I Note:
OSM Vector Basemaps includes two vector tile packages (.vtpk) on the flash drive. The

OSM_Vector_Basemap_DA2022_Install.vtpk file is in the Web Mercator Auxiliary Sphere (WMA) projection. The
OSM_Vector_Basemap_GCS_DA2022_Install.vtpk file is in the WGS84/GCS (GCS) tiling scheme. The following

steps reflect the sharing process of the WMA vector tile package. To share the GCS package, you need to enter the
correct .vtpk file name for the input package as well as take the GCS naming into consideration when publishing

the hosted tile layer. The OSM Vector Basemaps styles in the GCS directory already take the GCS naming into
account in the metadata files.

Upload the package to your ArcGIS Enterprise portal
First, you need to copy the entire USB flash drive contents to your local computer if you have not already done so.

1. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, and select Set As Active Portal.

Portals

E‘O https://your portal name/portal/

Available : Signed in as

Save As

I Note:
You must sign in and connect to your portal before you proceed. You cannot enter your portal user name and
password when using the Share Package tool later in these instructions. The tool obtains your credentials from

ArcGIS Pro.

Copyright © 1995-2021 Esri. All rights reserved. 16
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2. Create a project.

3. Select the Analysis tab, and select Tools in the Geoprocessing group.

[~ == - - 3

Home nsert Analysis view
QDB P K EaE L8 H B O

magery Share

History Python ModelBuwilder Environments Tools Ready To Feature Raster Spatial Chip ntersect
Use Tools~  Analysis~ Analysis ~ Jain
Geoprocessing B Portal

The Geoprocessing pane appears.

4. In the Geoprocessing pane, search for Share Package, and select the Share Package (Data Management

Tools) tool from the search results.

Geoprocessing X
€ |SharEPackagE X - 'b'
A
Share Package D=tz liznzgement Took
Shares a package by uploading to ArcGIS Online or ArcGIS
Enterprise.

-

Create Mobile Scene Package (Cztz Manzgement Tooks
Creates a mobile scene package file (.mspk) from ene or more
scenes for use across the ArcGlS platform.

-

Package Map (Cztz Management Tocks
Packages a map and all referenced data sources to create a single
compressed .mpkx file,

-

5. On the Share Package dialog box, provide the following:
a. For Input Package, provide the path to the vector tile package, for example, C:\Projects\

OSM_Vector_Basemaps_2022\VTPK\OSM_Vector_Basemap_DA2022_Install.vtpk.
b. For Summary, type OSM Vector Basemap for Data Appliance 2022.

c. For Tags, type 2022, v2.
A\ Caution:

Do not change the Credits parameter value and do not check the boxes to share with Everybody or Within
Organization.

Copyright © 1995-2021 Esri. All rights reserved.
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Geoprocessing - 1 x
© Share Package &)
Parameters Environments ?

Input Package
C:A\Projects\O5SM_Vector_Basemaps_202AVTPK\VOSM_Vector_Basemap_DA2022_|nstall vtpk

Summary
05M Vector Basemap for Data Appliance 2022

Tags
Credi;s
6. Select Run.
It will take approximately 30-120 minutes to upload the package to your portal. A Share Package Uploaded
Successfully message appears in the Share Package window once the upload is complete.

7. Through your portal, confirm that the .vtpk file uploaded successfully.
a. Open a web browser and sign in to your portal.
The OSM_Vector_Basemap_DA2022_Install tile package is located in the root folder.

b. Confirm that the Size value of the tile package is 40,143 MB and Shared with indicates that the item is not
shared.

Your item should look like the following:

O5M Vector_Basemap DAZ0Z2 Install #

Imptas Use Reguirements:

I Note:
If the size is not 40,143 MB, delete the item and upload the OSM_Vector_Basemap_DA2022_Install tile package
again. You may want to discuss the problem with your portal administrator.

For the OSM_Vector_Basemap_GCS_DA2022_Install tile package, if the size is not 39,991 MB, delete the item and
upload it again.

See the Troubleshooting OSM Vector Basemaps topic for more information.

Publish the hosted tile layer (service)

Now you'll publish the OSM Vector Basemap hosted tile layer service from your portal.

Copyright © 1995-2021 Esri. All rights reserved. 18
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1. Sign in to your ArcGIS Enterprise portal.

I Note:
Your account must have publishing credentials.

2. In My Content, go to the item page for the vector tile package (OSM_Vector_Basemap_DA2022_Install.vtpk)
you uploaded to your portal.
3. Click Publish, change the title to OSM_Vector_Basemap_v2, and click Publish again.

Publish X

Publish this item as a hosted layer.

O5M_Vector_Basemap_v2

ags:

2022 X||v2 X

Cance

I Note:
For the GCS tile package (OSM_Vector_Basemap_GCS_DA2022_Install.vtpk), change the title to

OSM_Vector_Basemap_GCS_v2.

I Note:
It will take 30-120 minutes to create the hosted layer, depending on your system configuration.

The OSM_Vector_Basemap_v2 hosted tile layer is created.

| Title
[] B OSM_Vector Basemap_v2 Tile Layer {hosted)
D 28 OSM_Vector_Bazsemap_DAZ2022_Instal Vector Tile Package

Publish tile layers (map styles)

You'll publish your map styles next.

The VectorStylePublisher geoprocessing toolbox can be run in ArcGIS Pro. This toolbox publishes 10 new tile layers
to your portal.

Copyright © 1995-2021 Esri. All rights reserved. 19
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These instructions assume that the toolbox and VectorBasemapStyles folder are on your local computer.

. B » ThisPC » O5Disk(C) » Projects » OSM_Vector_Basemaps 2022
Program Files (x86) " Name Type
Projects Toolbox
O5M_Vector_Basemaps_2022 VectorBasemapStyles
Toolbex VTPK

VectorBasemapStyles () data_sppliance_osm_vector_basemaps

VTPK

I Note:
You must have a portal account assigned to the default publisher or administrator role, or your account must be

assigned to a custom role that has privileges to create content and publish hosted tile layers.

1. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, and select Set As Active Portal.

2. Create a project.

3. Select the View tab, select Catalog View in the Windows group, right-click Toolboxes, and select Add
Toolbox.

"= =T - - 5

Catalog nsert Analysis Wiew Imagery Share
i : | » f— A [/] Show Details Panel [iE] Display Type -
O E = E BEE E y

Reset Catalog Catalog Contents Python Tasks Reviewer Workflow X
Panes~ Pane View Rules Manager= || Show Pop-ups

Windows Options
NALTTIN = cotoiog x|

| Search My Organization__| More Detail

)|+ Project »
Maps
E R Add Toolbox [}
B NewTooloox Add Toolbox
Ed Mew Python Toolbex o i
f . Add an exist \e proje
Databases saves a reference t

4. Browse to the location on your local computer where you copied the contents of the USB flash drive, select
VectorStylePublisher.tbx, and select OK.

- v » This PC » O35Disk(C:) » Projects » OSM Vector Basemaps 2022 » Toolbox
Program Files (x35) " Name 2 Type
Projects 6% DA2022_OSM_GCS_StyleUpdater template  Mic ¢
OS5 _Vector_Basemaps_2022 B DA2022_0SM_WMA_StyleUpdater_template C
Toolbox 3 VectorStylePublisher

VectorBasemapStyles @ VectorStyleUpdater ArcGIS

VTPK
The VectorStylePublisher toolbox is added to the project.
5. Double-click Toolboxes and double-click VectorStylePublisher.tbx.

Copyright © 1995-2021 Esri. All rights reserved.
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—

'i(_-:' '\T:' |:| ¥ Project » Toolboxes »

MyProject.tbx

6. Double-click the Vector Style Publisher script.

':.(:—3' 'Ei‘:' D » Project » Toolboxes » VectorStylePublis

— Vector Style Publisher

7. On the Vector Style Publisher dialog box, select the Parameters tab and provide the following:

Geoprocessing - 1 X
® Vector Style Publisher (&)
Parameters Environments f

Folder containing vector styles
WMA_NewUser

Vector Tile Service URL
https://<portal name>/server/rest/services/Hosted/O5SM_Vector_Basemap_v2/VectorTileServer

Metadata folder name
metadata

[T] Share vector style web layers publicly
* PKI Authorization

» Linux LDAP

a. For Folder containing vector styles, browse to the location of the VectorBasemapStyles folder on your local
computer, for example, C: \Projects\OSM_Vector_Basemaps_2022\VectorBasemapStyles\WMA\

WMA_NewUser.

b. For Vector Tile Service URL, provide the URL of the OSM Vector Basemap hosted tile layer, for example,
https://portalname.domain.com/arcgis/rest/services/Hosted/0SM_Vector_Basemap_v2/

VectorTileServer.

Copyright © 1995-2021 Esri. All rights reserved. 21
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I Note:
The vector tile service URL is found in the URL section of the OSM_Vector_Basemap_v2 hosted tile layer

item page. Click the Copy button and paste the URL in the Vector Tile Service URL parameter text box.

OSM_Vector_Basemap v2 &

Opan i Map Viawrar

c. For Metadata folder name, keep the default name metadata.

L Note:
If you are using a portal with PKI authentication, expand PKI Authorization and provide values for the

PKI_Certificated_file_(.pfx) and PKI Private Password parameters.

v PKI Authorization
PEI_Certificated_file_{.pfx)

PKl Private Password

If you are using a portal with Linux LDAP authentication, expand Linux LDAP and provide values for the
Sign In Username and Sign In Password parameters.

v Linux LDAP

Sign In Username

Sign In Password

d. Click Run.

The 10 vector tile layers (map styles) are created in your assigned ArcGIS Enterprise account. You can view the items
in My Content. Twelve items are listed: 10 vector tile layers, the .vtpk file, and the hosted tile layer.

Share tile layers (map styles)

The items created are private unless you check the Share vector style web layers publicly check box to make
them public.

Copyright © 1995-2021 Esri. All rights reserved. 22
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Geoprocessing ~ 8 x
@ Vector Style Publisher (’.B
Parameters Environments @

Folder containing vector styles
C:\Projects\OSM_Vector_Basemaps_2022\VectorBasemapStyles\WMA\WMA_Newlser

Vector Tile Service URL
hitps /f<portal name=iserverrest/services/Hosted/OSM_Vector_Basemap_vZNectorTieServer

Metadata felder name
gtadata

pre vector style web layers publicly
Authorization
* Linux LDAP

Alternatively, you can select the map items in your portal and change the sharing settings.

Share

Share the itemn(s

Everyone

Authentication

These sentings will replace the current semings.

Mo groups available to share to.
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I Note:
Delete protection for all items is applied upon publishing the tile layers. To change the protection setting, open the

item and click the Settings tab. Under Delete Protection, uncheck Prevent this item from being accidentally

deleted and click Save.

OpenStreetMap
General Tile Layer
General

Content Status

Recommend the use of this item.

noritative

Mark as Aut

Discourage the use of this item.

Mark as Deprecated

Delete Protection

';.—'"".T this itern from being accidentally deleted.

Extent

Set an extent to make your item searchable oy ocation.

Once you set up OSM Vector Basemaps, you can do the following:
» Use OSM Vector Basemaps

« Customize styles
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Set up OSM Vector Basemaps (existing user)

These steps are for updating your OSM Vector Basemaps in WMA.

I Note:
To use OSM Vector Basemaps in the GCS format, complete the steps using the information for GCS.

For information about what's included with OSM Vector Basemaps, see OSM Vector Basemaps content and What's
new.

You'll use the following workflow to update OSM Vector Basemaps:
1. Upload the package to your ArcGIS Enterprise portal

2. Publish the new hosted tile layer (service)

I Note:
The title of your new hosted tile layer must be different than the title of your existing hosted tile layer (for

example, the name of the new layer is OSM_Vector_Basemap_DA2022_v2).

Replace the existing hosted tile layer (service) with the new hosted tile layer

Update existing tile layers (map styles)

v~ W

Publish new tile layer (map style)
6. Share tile layers (map styles)
Upload the package to your ArcGIS Enterprise portal

First, you need to copy the entire USB flash drive contents to your local computer if you have not already done so.
Review the system requirements to confirm that you can deploy the OSM Vector Basemaps update.

1. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, and select Set As Active Portal.

Portals

C:Qi https://your portal name/portal/

Awailable : Signed in as

Save As .
Test Availab ity

I Note:
You must sign in and connect to your portal before you proceed. You cannot enter your portal user name and

password when using the Share Package tool later in these instructions. The tool obtains your credentials from
ArcGIS Pro.

2. Create a project.
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3. Select the Analysis tab, and select Tools in the Geoprocessing group.

[ SIS = v r 5

Home nsert Analysis View magery share
DO 3 S e L8 B o

Histery Python ModelBuilder Emvironments Teols Ready To Feature Raster \D: ia Clip ntersect
Use Tools~  Analysis= Analysis ~

Geoprocessing E) Portal
The Geoprocessing pane appears.

4. In the Geoprocessing pane, search for Share Package, and select the Share Package (Data Management

Tools) tool from the search results.

Geoprocessing >3 x
(:—;l 4 :‘i‘)
A
Share Package (Dztz lMznzgement Took
Shares a package by uploading to ArcGIS Online or ArcGIS
Enterprise.
s

Create Mobile Scene Package D=tz IMznzgement Took
Creates a mobile scene package file (.mspk) from ene or more
scenes for use across the ArcGl5 platform.

-

Package Map (Datz Manzgement Tooks
Packages a map and all referenced data sources to create a single
compressed .mpkx file,

-

5. On the Share Package dialog box, provide the following:
a. For Input Package, provide the path to the vector tile package, for example, C:\Projects\

OSM_Vector_Basemaps_2022\VTPK\OSM_Vector_Basemap_DA2022_Install.vtpk.
b. For Summary, type OSM Vector Basemap for Data Appliance 2022.

c. For Tags, type 2022, v2.

/A, Caution:
Do not change the Credits parameter value and do not check the boxes to share with Everybody or Within
Organization.
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Geoprocessing - 1 x
© Share Package &)
Parameters Environments ?

Input Package
C:A\Projects\O5SM_Vector_Basemaps_202AVTPK\VOSM_Vector_Basemap_DA2022_|nstall vtpk

Summary
05M Vector Basemap for Data Appliance 2022

Tags
2022, v

Credits

6. Select Run.
It will take approximately 30-120 minutes to upload the package to your portal. A Share Package Uploaded
Successfully message appears in the Share Package window once the upload is complete.
7. Through your portal, confirm that the .vtpk file uploaded successfully.
a. Open a web browser and sign in to your portal.
The OSM_Vector_Basemap_DA2022_Install tile package is located in the root folder.

b. Under Details, confirm that the Size value of the tile package is 40,143 MB and Shared with indicates that
the item is not shared.

Your item should look like the following:

O5M Vector_Basemap DAZ0Z2 Install #

Imptas Use Reguirements:

I Note:
If the size is not 40,143 MB, delete the item and upload the OSM_Vector_Basemap_DA2022_Install tile package
again. You may want to discuss the problem with your portal administrator.

For the OSM_Vector_Basemap_GCS_DA2022_Install tile package, if the size is not 39,991 MB, delete the item and
upload it again.

See the Troubleshooting OSM Vector Basemaps topic for more information.

Publish the new hosted tile layer (service)

Now you'll publish the new OSM Vector Basemaps hosted tile layer service from your portal.
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1. Sign in to your ArcGIS Enterprise portal.

I Note:
Your account must have publishing credentials.

2. In My Content, go to the item page for the vector tile package (OSM_Vector_Basemap_DA2022_Install.vtpk)
you uploaded to your portal.

3. Click Publish, change the title to OSM_Vector_Basemap_DA2022_v2, and click Publish again.

Publish X
Publish this item as a hosted layer.
; OSM_Vector_Basemap_DA2022 w2

2022 X || w2 X

m‘ s |

I Note:
For the GCS tile package, use the OSM_Vector_Basemap_GCS_DA2022_Install.vtpk file. Change the title to
OSM_Vector_Basemap_GCS_DA2022_v2 for the hosted tile layer that gets published.

I Note:
It will take 30-120 minutes to create the hosted layer, depending on your system configuration.

The OSM_Vector_Basemap_DA2022_v2 hosted tile layer is created.

Title
B OSM_Vector_Basemap_DA2022_v2 Tile Layer (hosted {EB
2 OSM_Vector_Basemap_DA2022_Insta Vector Tile Package Eg

Replace the existing hosted tile layer (service) with the new hosted tile layer
(service)

Next, you'll replace the 7.2 basemap hosted tile layer (service) with the 2022 hosted tile layer (service).

1. Sign in to your ArcGIS Enterprise portal.

Copyright © 1995-2021 Esri. All rights reserved. 28



ArcGIS Data Appliance: OpenStreetMap Vector Basemaps

I Note:
Your account must have publishing credentials.

2. In My Content, go to the item page for the OSM_Vector_Basemap_v2 vector tile service.

3. Click Replace Layer.

QOSM_Vector_Basemap_v2 ¢

——— B Tile Layer (hosted) by <Ussr_name=

Sesri
DATA APPLIANCE 7.2
WMA

4. Click Select.
___t___ OSM_Vector_Basemap_DA2022_v2

Gesri BB Tile Layer by fUsscsames Updated: 8/1%/21
WA i PITLT s S o
OSM Vector Basemap for Data Appliance 2022

I Note:
If you're using an ArcGIS Enterprise 10.7.1 portal, click Select Layer and select the newly published

OSM_Vector_Basemap_DA2022_v2 layer.

Replace Layer

Replacement Layer

Select layer

5. For Archive the current layer as, click the edit button and change the value to OSM_Vector_Basemap_DA72_v2
and click Save. Then, if you're using an ArcGIS Enterprise 10.8 or later portal, scroll to Replace Item information

and turn it on.
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® Aschive the current layer as O5M_Vector_Basemap_v2_3021_08_20_09_

The content of the current layer is archived. A new layer is created to archive the current layer. The replacement kayer is deleted afterwards.

Curena layer

+ The ftem id and URL of the cument layer is retained 50 that apps and styles
rafeancing the Liper continue towork (”

= The content of the cument layer is srchived as & rarw Layer.

= The replacement layer is deleted after the current layer is replaced.

Saclpenrmact e
= Klgalfor craating detignated lien for archived.

O

Use the replacement layer as the archive

The content of the cyrment Layer is swapped with the content of the replacement layer.

+ Mo rww luyers are created. The 2em id and URL of both the current layer
yer are retained 50 that apos and shles referencing the
Lipers Continue b work,

and replaceme

= ideal for environmaents that do not want to create a designated layer for

archiving.

Replace item information

This will uodate the item informaticn from the repfacemunt layer, inchuding: thumbead, summary, description, and tags.

6. Click Next.

7. On the Replace Layer summary, click Replace.

Replace Layer

Select replacement layer Choose archive option Summary

Curraft iy

OSM_Vector_Basemap_v2

B Tie Layer by simsmmes

Fmplasarant Layes

OSM_Vector_Basemap_DAZ2022_v2

BB Tie Layes by e

This replacement layer has siyle differences that may rot be compatibhe with the current layer.

Archive option

o durchiv

current layer a3 OSM_Vector_Basemap_DAT2_v2
+ Replace it informanon
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I Note:

The current layer starts as DA7.2. The replacement layer is DA2022. You are archiving the DA7.2 hosted tile
layer, and the current layer (OSM_Vector_Basemap_v2) now displays the DA2022 hosted tile layer. Replacing the
tile set allows the item ID and URL paths to remain intact so maps and apps continue to work with the current
layer and display the new DA2022 basemap content.

I Note:
If you're using an ArcGIS Enterprise 10.7.1 portal, check the Replace item information check box. Click
Replace.

Replacement options

M Replace item information.

This will use the following information from the
replacement layer:

» thumbnai

» summary

* gescrnption

» tags
w
Cancel Replace
: —

In a few minutes, the Success message appears.

Replace Layer

v

Success

Your layer has been replaced.

Please verify that dependent maps and layers work as expected.

Close

Click Close.
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If you're using an ArcGIS Enterprise 10.8 or later portal, the Success message flashes briefly at the top of the

screen.

8. To verify a successful replacement, in My Content, go to the item page for the OSM_Vector_Basemap_v2

vector tile service.
Your item should look like the following:

I Note:

O5M_Vector_Basemap_v2 #

.

@esri
DATA APPLIANCE 7.2
WMA

Description

Layers

Terms of Use

Impertant Use Requirements: This layer
red other connecied ArcGIS apbs

Share
&

The thumbnail is not replaced, but the title is OSM Vector Basemap for Data Appliance 2022 and the Details

section indicates it was created from the OSM_Vector_Basemap_DA2022_Install Vector Tile Package.

Update existing tile layers
Use the Vector Style Updater tool to update your existing layers.

1. Open the DA2022_0SM_WMA_StyleUpdater_template.csv file located in the C:\Projects\
OSM_Vector_Basemaps_2022\Toolbox folder.

a. Include the item IDs of all your existing styles in the itemid column in this table. The item ID for each style
can be obtained from the portal URL for each style. Only copy and paste the series of letters and numbers

after ...id=.

&
Q @ nttps: <portal name=> fid=1455d84d5a2bddbdb1191e0d2eedd2bl ~ad

ArcGIS Pricing Map Scene Help

OpenStreetMap (Esri Street style)

b. Once you fill in the itemid column, save the file and rename it DA2022_0SM_WMA_StyleUpdater.csv.
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File Home  Insen Dirare Page Layout Formulas Data Feview  View

= X Calibi w1 .
Og : e

Pate -2 ruU-|AA

- S A

| cgbosrd & Font [
B13 i j 2
A

itemid

ebod11 bEbEbELFOdElGeSfabdac0361d
a27d e Td13404 14bbE11 628608 eedhed
236295953 2c 0529220001 207121524
bAddass3Ba0c 140630007 33245012
649564148 1bod L5651 BaageTdis2
Gbb3radaanaddl Deal7ci3d4afasTIbs
370 Thce38bfabibbbasibadeiasddle
| § |35e942ca272445F7214b8bbb e 583
10 | 4653a7FaTd534326abded FhcSciboses

R R R SRR

- | 5% Y [EEromatis Table~
i 5 T52 Coll Styhes ~

Humbt W Syl

title

Openttreethap

OpenStreetMap [with Relief]

OpenstieetMap [Esfi Hybrid Reterente style]
OpenstreetMap [Esei Streat with Relief styla)
OpenStreethMap [Esri Street style)
OpenStreetMap (Esni Dark Gray Canvas Base)
OpenttrentMap [Esri Dark Gray Canvas Reference)
OpenttreetMap [Esri Light Gray Canvas Base)
Openstresthap [Esri Light Gray Canvas Reference)

Genargl « [ Conditional Formatting «

<% Share 2 Comments

Cili Editing Ideai | Senditiity

foldernamie

openstrestmap

opensireetmaprelied
epenstrestmapesiybrdstyle
openstrestmapesristreetreliefstyle
openstreetmapesrisireetstyle
cpenstreetmapesridarkgraycanvasbase
opanstreetmapesridarigraycanvasng ference
openstreetmapesrilightgraycanvasbase
openitrestmapesrilightgraycanvasreferenoe
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2. Run the Vector Style Updater tool.
a. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, and select Set As Active Portal.

b. Create a project.

c. Select the View tab, select Catalog View in the Windows group, right-click Toolboxes, and select Add
Toolbox.

d. Browse to the location on your local computer where you copied the contents of the USB flash drive, select
VectorStyleUpdater.tbx, and select OK.
The VectorStyleUpdater toolbox is added to the project.

e. Double-click Toolboxes, and double-click VectorStyleUpdater.tbx.

f. Double-click the Vector Style Updater script.

{(:—} 'ﬁﬁ' |:| ¥ Project » Toolboxes » VectorStyleUpdater.thx

— Vector Style Updater

B

g. On the Vector Style Updater dialog box, select the Parameters tab and provide the following:

Geoprocessing -3 x
VY P
(3] Vector Style Updater &+
Parameters Environments ()]

C5SY formatted file containing the item name and ids (.csv)
Vector_Basemaps_Build\Toolbox\DA2022_0SM_WMA_StyleUpdater.csv

Folder containing vector styles
WMA_UpdatedStyles

Vector Tile Service URL
<portal name= /services/Hosted/O5M_Vector_Basemap_v2/VectorTileServer

Metadata folder name
metadata

[[] Share vector style web layers publicly

i. For CSV formatted file containing the item name and ids (.csv), browse to the location of the
DA2022_0SM_WMA_StyleUpdater.csv file on your local computer.
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ii. For Folder containing vector styles, browse to the location of the WMA Updated Styles folder on your
local computer, for example, C:\Projects\OSM_Vector_Basemaps_2022\VectorBasemapStyles\WMA\

WMA_ExistingUser\WMA_UpdatedStyles.
iii. For Vector Tile Service URL, provide the URL of the OSM Vector Basemap tile layer that you replaced
above, for example, https://portalname.domain.com/arcgis/rest/services/Hosted/

OSM_Vector_Basemap_v2/VectorTileServer.

I Note:
The vector tile service URL is in the URL section of the OSM_Vector_Basemap_v2 hosted tile layer item

page. Click the Copy button and paste the URL in the Vector Tile Service URL parameter text box.

OSM_Vector_Basemap_v? #

s

@esri

DATA APPLIANCE 7.2

Abinar_pame:

iv. For Metadata folder name, keep the default name metadata.

I Note:
If you are using a portal with PKI authentication, expand PKI Authorization and provide values for the

PKI Certificated file (.pfx) and PKI Private Password parameters.

v PKI Authorization
PKI_Certificated_file_(,pf)

PKIl Private Password

If you are using a portal with Linux LDAP authentication, expand Linux LDAP and provide values for the
Sign In Username and Sign In Password parameters.

v Linux LDAP

Sign In Username

Sign In Password
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3. Click Run.
It can take up to a minute to update each existing style in your portal using the Vector Style Updater tool.

The VectorStyleUpdater toolbox displays a successful update message when complete.

The nine vector tile layers (map styles) are updated in your assigned ArcGIS Enterprise account. You can view the

nine items in My Content.

Publish new tile layer (map style)

You'll publish the new map style next.
The VectorStylePublisher geoprocessing toolbox can be run in ArcGIS Pro. This toolbox publishes new private map
items in your portal for one new vector tile layer.

1. In the ArcGIS Pro project you created to update the existing styles, select the View tab, select Catalog View in
the Windows group, right-click Toolboxes, and select Add Toolbox.

==
Project Catalog nsert Analysis View Imagery Share
I:rr' r R » | — F /] Show Details Pane [E] Display Type ~
g | v
b _ h | Search My Organization_| More Detail
Reset Catalog Catalog Contents Python Tasks Reviewer Workflow
Panes~ Pane View Rules Manager= |v| Show Pop-ups
Windows Options
NALVTIN = Cooiog x|
1)\l v Project »
Maps
& FH Add Toolbex D}
Ed New Toolbox Add Toolbox
Ed Mew Python Toolbex A P a LT "
- Add an existing toolbox to the projec he project
D saves a reference to the toolbox.

2. Browse to the location on your local computer where you copied the contents of the USB flash drive, select
VectorStylePublisher.tbx, and select OK.

- v o » ThisPC » O5Disk(C:) » Projects » OSM_ Vector Basemaps 2022 » Teolbox

Program Files (x28) ot Name

Fropects (33) DA2022_0SM_GCS_StyleUpdater_template

OSM Vector_Basemaps_2022 B DA2022_0SM_WMA,_StyleUpdater_template
Toolbox &3 VectorStylePublisher

VectorBasemapStyles B VectorStyleUpdater ArcGIS

VTPK

The VectorStylePublisher toolbox is added to the project.
3. Double-click Toolboxes, and double-click VectorStylePublisher.tbx.
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(_-jl le |:| ¥ Project » Toolboxes »

MyProject.tbx

VectorStylePublisher.tbx

4. Double-click the Vector Style Publisher script.

(_—J' ‘!‘,' D » Project » Toolboxes » VectorStylePublis

— Vector Style Publisher

E[ Serit

5. On the Vector Style Publisher dialog box, select the Parameters tab and provide the following:
a. For Folder containing vector styles, browse to the location of the WMA New Styles folder on your local
computer, for example, C:\Projects\OSM_Vector_Basemaps_2022\VectorBasemapStyles\WMA\
WMA_ExistingUser\WMA_NewStyles.

b. For Vector Tile Service URL, provide the URL of the OSM Vector Basemap tile layer, for example,
https://portalname.domain.com/arcgis/rest/services/Hosted/0SM_Vector_Basemap_v2/
VectorTileServer.

I Note:

The vector tile service URL is in the URL section of the OSM_Vector_Basemap_v2 hosted tile layer item
page. Click the Copy button and paste the URL in the Vector Tile Service URL parameter text box.

c. For Metadata folder name, keep the default name metadata.
Geoprocessing X

® Vector Style Publisher @
Parameters Environments
Folder containing vector styles
WMA_MewStyles
Vector Tile Service URL

<portal name= /services/Hosted/O5M_Vector_Basemap_vZ/VectorTileServer

Metadata folder name
metadata

[_] Share vector style web layers publicly
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I Note:
If you are using a portal with PKI authentication, expand PKI Authorization and provide values for the
PKI_Certificated_file_(.pfx) and PKI Private Password parameters.

v PKI Authorization

PK|_Certificated_file_(.pfx)

PKl Private Password

If you are using a portal with Linux LDAP authentication, expand Linux LDAP and provide values for the
Sign In Username and Sign In Password parameters.

¥ Linux LDAP

Sign In Username

Sign In Password

d. Click Run.

The new vector tile layer (map style) is created in your assigned ArcGIS Enterprise portal account. You can view the
item in My Content. Fourteen items are listed: 10 vector tile layers (1 new plus 9 existing), both 7.2 and 2022 .vtpk

files, and the active and archived hosted tile layers.

Share tile layers (map styles)

The items created are private unless you check the Share vector style web layers publicly check box to make
them public.

Geoprocessing w1

® Vector Style Publisher ®

Parameters Environments
Folder containing vector styles
WMA_MewStyles

Vector Tile Service URL
<portal name> /services/Hosted/O05SM_Vector_Basemap_vZ/VectorTileServer

Metadata folder name
metadata

hare vector style web layers publicly

Alternatively, you can select the map items in your portal and change the sharing settings.
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Share

Share the itern(s) with:

Everyone

Authentication

These settings will replace the current semtings.

Mo groups available to share to.

I Note:

Delete protection for all items is applied upon publishing the tile layers. To change the protection setting, open the
item and click the Settings tab. Under Delete Protection, uncheck Prevent this item from being accidentally
deleted and click Save.

OpenStreetMap Overview

General Tile Layer

General

Content Status

Recommend the use of this item.

‘ Mark as Authoritative

Discourage the use of this item.

| Mark as Deprecated

Delete Protection

';e=:'17 this itern from being accidentally deleted.

Extent

Set an extent to make your item searchable oy ocation.

Once you set up the OSM Vector Basemaps update, you can do the following:

» Use OSM Vector Basemaps

Copyright © 1995-2021 Esri. All rights reserved. 38



ArcGIS Data Appliance: OpenStreetMap Vector Basemaps

+ Customize styles
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Troubleshooting OSM Vector Basemaps

Listed below are issues you may encounter when working with OSM Vector Basemaps content as well as
recommended solutions.

« What if the size of the uploaded .vtpk file does not match the size of the source .vtpk file?

« What if | encounter the There was an error message when | try to publish the service?

» What do | do if the progress bar keeps loading when I'm trying to publish my service?

What if the size of the uploaded .vtpk file does not match the size of the source .vtpk file?

If your hosted tile layer service did not publish successfully, an issue may have occurred during the upload of the
vector tile package (.vtpk) file to your portal. The size of the . vtpk file on disk and the size of the uploaded file on

your portal must match.
The size of the 0SM_Vector Basemap DA2022 Install.vtpk file is 40,143 MB and the
OSM_Vector_Basemap_GCS_DA2022 Install.vtpk file is 39,991 MB.

You can check the size of the uploaded vector tile package (supporting the service) on the item details page. The
following screen capture shows the OSM_Vector_Basemap_DA2022_Install vector tile package details:

Details

Size: 40,143 MB

Shared with: The item is not shared.

If the size does not match, review the log via the server manager to see if there are any errors.

In some cases, the ArcGIS Pro Share Package geoprocessing tool may have produced a Success message, but when
you check the size of the . vtpk file from the item details page, it does not match. Here are some things that you
can try to resolve this issue:

+ Upload the .vtpk file again. First, delete the 0SM_Vector_Basemap_DA2022_Install.vtpk or
OSM_Vector_Basemap_GCS_DA2022_Install.vtpk file from your portal. Next, upload the
OSM_Vector_Basemap_DA2022_Install.vtpk or OSM_Vector_Basemap_GCS_DA2022_Install.vtpk file again
using the ArcGIS Pro Share Package geoprocessing tool.

« Verify with your portal administrator that there is at least 82 GB of disk space per .vtpk file available on your
portal. Make sure there is space on <ArcGIS portal install drive>\arcgis\arcgisportal where the

content items are stored.
- Verify that you are using a supported version of ArcGIS Pro. See the system requirements for details.

Contact Esri Technical Support if you still cannot successfully upload the .vtpk file.

I Note:
The following answers reflect troubleshooting of the WMA vector tile package and service. To troubleshoot the GCS
vector tile package and service, you need to take the GCS naming into consideration.
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What if | encounter the There was an error message when I try to publish the service?
Work with your systems administrator to check the ArcGIS Server Manager logs.

If there is an error due to a geoprocessing service (PublishingTools) timing out or crashing, you may have skipped a
system requirements step. Confirm that you changed the value of The maximum time a client can use a service
to 21,600 seconds.

Once you have updated the geoprocessing service maximum time, do the following:

1. On your server, delete the OSM_Vector_Basemap_v2 or OSM_Vector_Basemap_GCS_v2 hosted tile layer.

2. On the ArcGIS Server machine, delete the job in the <ArcGIS_Server_Install_Path>\arcgis\

arcgisserver\directories\arcgisjobs\system\publishingtools gpserver\<Job_ID> folder.

I Note:
You can find the job ID in the log file.

3. Restart the server.

4. Verify that you have at least 82 GB of available space per .vtpk file on ArcGIS Server.

5. In your portal, publish the OSM_Vector_Basemap_v2 or OSM_Vector_Basemap_GCS_v2 tile layer again.

Copyright © 1995-2021 Esri. All rights reserved. 41



ArcGIS Data Appliance: OpenStreetMap Vector Basemaps

What do | do if the progress bar keeps loading when I'm trying to publish my service?

Overview

# Edit Thumbnail

Creating Service

* Add to Favorites

If the Creating Service progress bar continues to load after two hours, the browser connection to the portal may
have failed.

Sign out of the portal and sign in again to see if the thumbnail has changed to the Data Appliance 2022 icon,
because the browser connection does not affect the creation of the service.

Home Gallery Map Scene

OSM_Vector Basemap_DA2022_v2

/# Edit thumbnail

. OSM World Base

3 R
- OpenSireelMap # Tile Layer (hot

@esrl Created: May 11, 2
DATA APPLIANCE 2022
WMA

¥t Add to Favorites

If the thumbnail changes to the Data Appliance 2022 icon, confirm that the map displays as expected.
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Additional resources

The following resources are available for OSM Vector Basemaps:

ArcGIS Data Appliance 2022: OSM Vector Basemaps help [PDF]

ArcGIS Data Appliance 2022: Esri Vector Basemaps New users video [captioned MP4] demonstrating uploading,
updating and publishing Esri Vector Basemaps to your portal—Instructions for uploading and publishing OSM
Vector Basemaps are similar to Esri Vector Basemaps. The names of the files and styles used in the video reflect
the source data. Substitute OpenStreetMap (OSM) file names for Esri Vector Basemaps file names when following
the instructions in the video.

ArcGIS Data Appliance 2022: Esri Vector Basemaps Existing users video [captioned MP4] demonstrating
uploading, updating and publishing Esri Vector Basemaps to your portal—Instructions for uploading and
publishing OSM Vector Basemaps are similar to Esri Vector Basemaps. The names of the files and styles used in
the video reflect the source data. Substitute OpenStreetMap (OSM) file names for Esri Vector Basemaps file
names when following the instructions in the video.

Tile layers, Customize basemaps, and Choose basemap in the Portal for ArcGIS help
Working with and Customizing Esri Vector Basemaps: The Basics blog post

Create a custom basemap style using the ArcGIS Vector Tile Style Editor on the ArcGIS Developer website (for
ArcGIS 10.8 or later users only)
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Use OSM Vector Basemaps

With the addition of vector tile packages (. vtpk), hosted tile layers, and tile layers in your portal, you will have a
number of items in your ArcGIS Enterprise Content window. With the correct administrative privileges, you can
create folders, groups, and categories. By creating folders and moving items into them, you can organize your
Content window to make it easier to find the items you are looking for. The following image shows some folder
name suggestions. See Manage content in the Portal for ArcGIS help for information on managing content in
ArcGIS Enterprise.

Content My Conta

Create new folder i

You can use OSM Vector Basemaps in your applications in the following ways:

« The 10 map tile layers (styles) can be added to a map in ArcGIS Pro or to Map Viewer Classic in your Enterprise
portal.
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[E] Details B Add ~ | BEBasemap | [ Analysis
< My Content »

2 OpenStreetMap

10 layers

i
-
—
=

dll

OpenStreetMap
B by
Updeted: 6/21/21

OpenStreetMap (Blusprint)
@ by
Updated: 6/21/21

@

OpenStreethMap (Esri Dark Gray Canvas

by
Updated: 6/21/21

@

OpenstreetMap (Esri Light Gray Canvas
Base)

by

Updated: 6/21/21

@

* The tile layers (styles) can be added to an existing basemap, or they can be added as the basemap.
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Detail: ¥ Add ~ | BBBasemap | F]Analysis »
My Content ! ' S =
é iy lontent » E s :
ool “H
A, OpenStrestMap by =2 A
——— e
10layers =& m= g
v
% Add 1o Fa
® .
OpenStreetMap &

B Tile Layer by

Updated: June 21, 2021

This vector basemap version of
o (Eafi Dark Gray Canvas OpenStreetMap (O5M) data is hosted by

Esri and rendered using OSM cartography.

Description

This tile layer presents a vector basemap of

OpenStreetMap (Esri Light Gray Canvas OpenStreetMap (O5M) data created by
Base Esri. Esri produced this vector tile basemap
8 by n AreGIS Pro from a live rep of OSM
Updated: 6/21/21 data that was rendered us ng O5SM
@ cartography.
-

Usa as Basemap |

« Three of the 10 map tile layers (styles) can be used with a raster layer—World Hillshade or World Imagery—as the
basemap in their web map:

= OpenStreetMap (with relief)—World Hillshade
= OpenStreetMap (Esri Street with Relief style)—World Hillshade
= OpenStreetMap (Esri Hybrid Reference style)}—World Imagery

« If you have a tile layer (style) in your map, it can be moved to the basemap.
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[E]Details #Add v | BHBasemap | EAnalysis

O About Content £= Legend

Contents

¥ OpenStreetMap (Esri Hybrid Reference style)

» @ & Zoom to
[[E} Transparency

& Set Visibility Range

Rename

o

B

x| Remove

Copy

39 Move to Basemap

Show ltem Details

« The Hybrid Reference layer can be moved to the basemap and set as the reference layer over the World Imagery
layer.

[E] Details  [H Add ~ | BB Basemap |EAnaI}rsis

0 About Content i Legend

Contents
4@ Imagery

OpenStreetMap (Esri Hybrid
Reference style)

B @ Zoom to
[[E} Transparency
&t Set Visibility Range

Rename

J» Move down

x| Remove

EZ Move from Basemap

}z) Set as Reference Layer J'"

Show ltem Details

 The OpenStreetMap Dark Gray or Light Gray Canvas Reference layers can be moved to the basemap and set as
the reference layer over the Canvas Base layer.
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Customize styles

With ArcGIS Data Appliance: OpenStreetMap Vector Basemaps, you can modify and customize the map style. You
can customize the map by changing the hex color codes of map features or labels, removing feature classes,
changing fonts (face, size, and color), or making other edits. For more information, see the vector basemap blog
post on the ArcGIS Blog website.

Customization requires changes to the map style's resources\styles\root. json file. There are two main ways to
customize your maps: add a style to the map in Map Viewer Classic or copy a root. json style from the USB flash

drive. In ArcGIS Enterprise 10.8 or later, you can use the ArcGIS Vector Tile Style Editor. Then you can edit the
custom style map item to include a new thumbnail and update the item's information for your custom style.

Add a style to the map in Map Viewer Classic and rename the style
To add a style using Map Viewer Classic, complete the following steps:

1. In your Enterprise portal, open the style you want to customize in Map Viewer Classic, for example,
OpenStreetMap.

2. Click More Options --- and select Copy.
[E] Details # Add B8Basemap | [E.
About | [E] Content £= Legend

1

ontents

¥ OpenStreetMap

A new OpenStreetMap - Copy layer is added to the top of the Contents pane.

3. Click More Options --- and select Save Layer.
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[E] Details B Add = | BBEasemap

Fl:

About [E] Content (= Legend
Contents

¥ OpenStreetMap - Copy

Zoom to

ozl

v O

r@

Transparency

.
L

Set Visibility Range

B

Rename

B
=

Move down

Copy

X M €

Remaove

E‘!‘I‘

Move to Basemap

Save Layer Jm

4. Rename the style, for example, Custom OpenStreetMap, and select the folder where you want to save the new
style.

5. In My Content, go to the item page for the new style and click the Download style button.

Custom OpenStreetMap #

Open in Map Viewer
Classic E

Description # Edn m

The style (root. json file) is saved to your computer.

6. Open the root.json file in a text editor such as Adobe Brackets or Notepad++, and edit and save the file.
Edits to the root. json file can be color value, line width, font size, and so on.

7. Validate the JSON using JSONLint or a similar JSON validation tool. You can also use this website to parse the
JSON into a more user-friendly format before editing.

8. On the item page for the new style, click the Update button to update the item and load the modified
root. json file from your computer to your portal.

Copy a style from the USB flash drive and rename the map style directory

To copy a root.json style from the USB flash drive, complete the following steps:

Copyright © 1995-2021 Esri. All rights reserved. 50


https://jsonlint.com/

ArcGIS Data Appliance: OpenStreetMap Vector Basemaps

1. On your local computer, create a directory called CustomStyles at the same directory level as the GCS and

WMA directories.
Projects » OS5M_Vector_Basemaps_2022 » VectorBasemapStyles »

Fa

Mame Type
CustomStyles File folder
GCS_styles File folder
WMA_styles File folder

2. Copy a style from the USB flash drive and rename the map style directory; for example, copy the openstreetmap
directory into a new directory and change the name to customopenstreetmap.

L S o O6DEk (C) » Projects » OSM Vector Basemaps 2021 » VectorBasemapStyles » CustomStyles » customopenstreetmap »
L O5M_Vector_Basemaps_2022 o Name Type
Toclbex metadata
b VectorBasernapStyles TESEUrCES

v CustomStyles
customopenstrestmap
GCS
WMA
VTR

3. In the new customopenstreetmap directory, open the resources\styles\root. json file (for example,
CustomStyles\customopenstreetmap\resources\styles\root.json) in a text editor such as Adobe

Brackets or Notepad++, edit the map code, and save the file.
An example of a style edit in the root. json file is changing the country boundary in purple (#AC46AC) to red

(#FF0000).

4. In the new customopenstreetmap directory, open the metadata\metadata. json file (for example,
CustomStyles\customopenstreetmap\metadata\metadata.json) in a text editor such as Adobe Brackets or
Notepad++, and edit "title":, replacing "OpenStreetMap" with a new map title, for example, "Custom
OpenStreetMap", and save the file.

= metadata json B3

i, = § g

: 1479514181000,
i=d": 1501816393000,
g "gquid™: null,
name™: null,
10 "titls": "Costom OpenStcreetMap™,
£ ": "Vector Tile Serviee™,

rords": ["Data™, "Service™, "Vector Til
E : "This wvector basemap version of
4 ["Data Appliance™, "2022™, "ArcGIS Data
15 "znippset": "This wector basemap wersion of Open
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5. Validate the JSON using JSONLint or a similar JSON validation tool.

6. Perform the publish tile layers (map styles) steps, this time pointing to the new directory containing your custom
style.

The new style is created in your Enterprise portal under My Content. Following the naming conventions in steps
1-4 produces a new item in your portal named Custom OpenStreetMap.

Edit the custom style map item in your portal

On the map item page of your custom map style, you can update the summary, description, tags, and thumbnail to
better describe the new map you styled.

It is recommended that you apply Delete Protection to your custom style map item on the item's Settings tab.

Custom OpenStreetMap

(O5MY)is hosted by Esri and rendered using OSM cartography. It

has red country boundary lines.
® Tile Layer by

Created: Jul 6, 202 Updated: Jul &

Description £ Edn

This vector tile layer is a customized version of the OpenStreetMap.

he country boundary lines were changed to red.
Home ¥ Custom OpenStreetMap

[E] Details  H Add ~ | BB Basemap | [F]Analysis EH~ = Share &~

=

Contents

#| Custom OpenStrestMap

» (@ Topographic
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Esri Vector Tile Style Editor

In ArcGIS Enterprise 10.8 or later, you can customize vector map styles through an app in Map Viewer Classic.
Access the Style Editor from the Change Style button under any OSM vector basemap tile layer. Save the new style

to your portal.

Details  # Add B8 Basemap
@0

About [Z] Content = Legend

Contents

- | OpenStreetMap

' .k Change Style

Styling options include the Quick Edit tool, in which layers are customized across groups of features, and the Layer
Style Editor list for individual feature style controls. Colors, line weights, font faces, and sprite symbology are
examples of the style changes that can be applied to your custom map item.

Change Style
& O resta r

& [=]=

o ©
4 .

= r

Information about using the ArcGIS Vector Tile Style Editor to Create a custom basemap style is available on the
ArcGIS Developer website.
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Terms of use
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Terms of use for ArcGIS Data Appliance: OpenStreetMap
Vector Basemaps

ArcGIS Data Appliance: OpenStreetMap Vector Basemaps should only be served from ArcGIS Server and Portal for
ArcGIS (10.7.1, 10.8, 10.8.1, or 10.9). ArcGIS Data Appliance: OpenStreetMap Vector Basemaps cannot be transferred
to or used with used with non-Esri technology.

For more information, see the Master License Agreement on the Esri website.
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Copyright information

Copyright © 1995-2021 Esri. All rights reserved. Published in the United States of America.
The information contained in this document is subject to change without notice.

You may have received Products or Services that include Graph Editor Toolkit, Copyright © 1992-1999 Tom Sawyer
Software, Berkeley, California, All Rights Reserved, and Tom Sawyer Visualization, Ver. 8.0 Copyright © 1992-2009
Tom Sawyer Software, Berkeley, California, All Rights Reserved.

Portions of this computer program are Copyright © 1995-2016 Celartem, Inc., dba Extensis. All rights reserved.

This application supports the ECW data format and ECWP compression protocols. Portions of this computer
program are Copyright © 2007-2015 Intergraph Corporation. All rights reserved. Creating compressed files using
ECW technology is protected by one or more of U.S. Patent No. 6,201,897, No. 6,442,298, and No. 6,633,688.

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-
identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other
Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2020. Pantone is the copyright owner of color
data and/or software which are licensed to Esri to distribute for use only in combination with the ArcGIS family of
Products. PANTONE Color Data and/or Software shall not be copied onto another disk or into memory unless as
part of the execution of the ArcGIS family of Products.

Third Party OSS-FOSS Acknowledgement Documents

Esri's use of open source software libraries is disclosed in the Third-Party OSS-FOSS Acknowledgement Documents
found at the link below.

Open Source Acknowledgements (https://links.esri.com/open-source-acknowledgments)

ArcGIS Notebooks make use of The FreeType Project, following The FreeType Project License
(https://git.savannah.gnu.org/cgit/freetype/freetype2.git/tree/docs/FTL.TXT).

EXPORT NOTICE

Use of these Materials is subject to U.S. export control laws and regulations, including the U.S. Department of
Commerce Export Administration Regulations (EAR). Diversion of these Materials contrary to U.S. law is prohibited.

US GOVERNMENT CUSTOMER

The Products are commercial items, developed at private expense, provided to Customer under this Master
Agreement. If Customer is a US government entity or US government contractor, Esri licenses or provides
subscriptions to Customer in accordance with this Master Agreement under FAR Subparts 12.211/12.212 or DFARS
Subpart 227.7202. Esri Data and Online Services are licensed or subscribed under the same DFARS Subpart
227.7202 policy as commercial computer software for acquisitions made under DFARS. Products are subject to
restrictions, and this Master Agreement strictly governs Customer's use, modification, performance, reproduction,
release, display, or disclosure of Products. Agreement provisions that are inconsistent with federal law regulation
will not apply. A US government Customer may transfer Software to any of its facilities to which it transfers the
computer(s) on which it has installed such Software. If any court, arbitrator, or board holds that a US government
Customer has greater rights to any portion of the Products under applicable public procurement law, such rights
will extend only to the portions affected. Online Services are FedRAMP Tailored-Low authorized but do not meet
higher security requirements, including those found in DFARS 252.239-7010.
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Esri Trademarks

Esri trademarks and product names mentioned herein are subject to the terms of use found at the following
website: Copyrights and Trademarks (https://links.esri.com/copyright-trademarks).

Licensed Trademarks

Other companies and products or services mentioned herein may be trademarks, service marks, or registered marks

of their respective mark owners.

The Kubernetes ship's wheel logo is a registered trademark of the Linux Foundation.

Trademark Images

Logos of licensed trademarks include the following:

OGC

Making location count.

PANTONE'
Digital Color
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Support

Support for ArcGIS Data Appliance: OpenStreetMap Vector Basemaps is provided by the Esri Technical Support
team.

Use one of the following contact options:

« United States users—Contact Esri Technical Support using one of the following options. Hours are Monday
through Friday, 9:00 a.m. to 5:00 p.m. (Pacific time), excluding Esri holidays:
= Phone: 888-377-4575

= Email: support@esri.com
= Web page: http://support.esri.com/contact-tech-support

* International users—Support is provided by your local Esri distributor.
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